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ABOUT THIS GUIDE

The instructions and descriptions contained in this document were accurate at the time of publishing;
however, succeeding products and documents are subject to change without notice. Therefore,
Window Book, Inc. assumes no liability for damages incurred directly or indirectly from errors,
omissions, or discrepancies between the product and this document.

This document is formatted for 2-sided printing.

wbSCAN™, DAT-MAIL™, Advanced Workflow Automation Manager™, AWAM™, Automation Scheduler™,
and PostalWeb Connector™ are trademarks of Window Book, Inc.

PostalOne!® is a registered trademark of the United States Postal Service.

Mail.dat® is a registered trademark of the International Digital Enterprise Alliance, Inc. (IDEAlliance).
ZEBRA™ is a trademark of ZIH Corp.

MOTOROLA™ is a trademark of Motorola Trademark Holdings, LLC.

Intermec?® is a registered trademark of Intermec Technologies Corporation.

Socket® is a registered trademark of Socket Mobile, Inc.

I0S® is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

Android™ is a trademark of Google LLC.

Scandit® is a registered trademark of Scandit AG.

Windows® is a registered trademark of Microsoft Corporation in the United States and/or other
countries.

All other product names are trademarks, registered trademarks, or service marks of their respective
owners.

Copyright © 2020 Window Book, Inc. All rights reserved. All intellectual property rights remain the
property of Window Book, Inc. No part of this publication may be reproduced, distributed, modified,
displayed, transmitted, stored in a retrieval system, or translated into any human or computer language,
in any form or by any means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise,
without the prior written permission of the copyright owner, Window Book, Inc., 300 Franklin Street,
Cambridge, MA 02139.
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CONTACT INFORMATION

WINDOW BOOK, INC.
300 Franklin Street
Cambridge, MA 02139

Corporate: 617-395-4500
Client Services: 800-524-0380
sales@windowbook.com

Support: Support Portal
800-477-3602

techsupport@windowbook.com
Fax: 617-395-5900

On the Web: www.windowbook.com

REVISION HISTORY

This section contains a list of any significant changes that were made from the previously published
version of this Guide, including a brief description of the change, the type of change made (i.e. Revision,
New, or Deletion), a link to the location in the Guide where the change occurred, and any pertinent
details relating to the change.

CHANGE | TYPE | LOCATIONIN GUIDE | DETAIL
ABOUT THIS GUIDE and
Updated section Revision | page footers throughout Updated copyright information.
document.

Removed mention alluding to the
use of Port 80 as a requirement.
Any port can be used for wbSCAN
(non-secure connections only).

Updated section Revision | REQUIREMENTS

Changed Step 1 in the procedure to

INSTALL & CONFIGURE generalize the port selected for

Updated section Revision THE WBSCAN SERVICE wbSCAN. Selected port does NOT
have to be port 80 (unsecure

connections only).
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Process is Monitoring Port
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Updated section Revision anv port being used
Now: DETERMINE WHAT yp g Lsed.
PROCESS IS MONITORING
PORT
DETERMINE WHAT Changed section to encompass an
Updated section Revision | PROCESS IS MONITORING g P y

PORT

port being used.
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BEFORE YOU BEGIN

SYMBOLS YOU SHOULD KNOW

The following symbols appear throughout this document:

o Where displayed, this Information icon denotes important information regarding the subject
matter at hand. The information is intended to provide helpful hints, references to other
locations in the document to help further understanding about the current subject-matter,
and/or include special requirements pertaining to specific subject-matter. It is important that
the information provided be read and thoroughly understood before proceeding.

(.-:.

Where displayed, this Attention icon is intended to make the reader take special notice as the
information provided is critical in nature to the subject matter at hand. It is not intended to
lessen the importance of the information provided with the Information icon noted above; but
to bring additional attention in situations of extreme necessity.

% Where displayed, this Troubleshooting icon denotes helpful hints and tips for the subject matter
at hand. The information in the troubleshooting tip is intended to provide helpful hints and
resolutions for some of the more common issues that can occur during operation.

PURPOSE

The purpose of this Guide is to provide installation instructions for woSCAN™ for use as a quality
assurance/verification tool to avoid costly assessments, and in conjunction with DAT-MAIL™’s Multi-
Carrier Trailer Manifesting. User instructions are provided in the wbSCAN User Guide.

INTRODUCTION

wbSCAN expands DAT-MAIL’s reach to our Client’s shop floor. This is a light-weight webserver that
allows the browser on network connected handhelds, tablets, and desktop computers to interact with
their DAT-MAIL data in real time. Current functions include:

e Remotely trigger PostalOne!® payments for activated pallets using “Scan2Pay”;
e Real-time trailer manifesting with LSC Logistics via the DIME™ interface;
o Alert if mailer attempt to add an origin pallet to a consolidation center manifest;

e Pallet warehouse inventory control;
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Mail production visibility and metrics;
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Automating DAT-MAIL back office functions like paying for postage and changing piece weights;

Quality assurance to avoid assessments, particularly nesting errors and undocumented pieces;

and

Improving shop floor productivity by providing tray tag and pallet placard reprinting functions..

REQUIREMENTS

The requirements for installing wbSCAN are dependent on how wbSCAN is being used. wbSCAN can be
used for quality assurance/verification purposes only. Mailers can also use wbSCAN in conjunction with
the Multi-Carrier Trailer Manifesting function provided in DAT-MAIL. The table below provides

information on what requirements are necessary for one or both use types.

wbSCAN USE
. Multi-
Quality ) . I
Carrier
Assurance / .
e Trailer
Verification e
REQUIREMENTS Manifesting
SERVER
Installation of wbSCAN must occur on the same server where the
DAT-MAIL program files reside (i.e. not on a workstation or a data
server).
[ X X
= The wbSCAN service cannot be executed on more than one
computer.
DAT-MAIL software version 21.19.08.13 (or newer) must be X X
installed.
The DAT-MAIL software must be registered using a wbSCAN-specific X X
registration key.
The DAT-MAIL/wWbSCAN server must have a static IP address. X X
Adequate machine memory to support sessions for each device that X X
will simultaneously access the service.
No other web server listening to the port selected for woSCAN use X X
(e.g. Port 80, or 443 — secure installations) on the DAT-MAIL server.
The port selected for wbSCAN use must be open to traffic X X
originating on the network.
Wireless router for the shop floor (if using wireless devices) X X

Page 8 of 38
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wbSCAN USE

Quality MUI,U_

Carrier
Assurance / .

e . Trailer

Verification . .

REQUIREMENTS Manifesting

SERVER (continued)

The following must be completed in DAT-MAIL before using
WbSCAN: Carrier and Distribution Lists must be added, and the
necessary settings completed in the Setup screen’s Logistics tab for
Non-LSC and/or LSC Users. Refer to the “Multi-Carrier Trailer
Manifesting Setup & User Guide”; specifically, the “Getting Started”
section for instructions.

Installation of the most recently published version of the
Automation Scheduler™ with Auto Postal Updates plug-in (refer to X
OTHER COMPONENT INSTALLATION for more information).

AWAM™ must be activated (requires an AWAM registration key)
and set up in DAT-MAIL for Scan2Pay users incorporating X
automation into their workflow.

wbSCAN’s Scan2Pay must be enabled and set up in DAT-MAIL. X

For Scan2Pay users fully automating the postage payment process,
PostalWeb Connector™ must be installed (requires a PostalWeb
registration key) and configured for uploading Mail.dat files to
PostalOne!. This also requires additional setup in DAT-MAIL.

SCANNING DEVICES

PC’s and Tablets using USB wired or Bluetooth “wedge” scanners
(such as the Socket® Mobile Durascan D700).

e Wireless devices —includes but is not limited to, most
Windows® CE industrial devices with “keyboard wedge” browser
functionality. These devices can be purchased new, refurbished
or used:

~  ZEBRA™ TC-51 or TC-56; X X

~ MOTOROLA™ models MC9090G; MC9200, MC9190,
MC55A0; and

~ Intermec® CKS5.

Smart Phones: iOS® and Android™ devices require the Scandit®
Keyboard Wedge app (inquire for details) or the Socket® Mobile
Durascan D700, and a hardened case and extended battery are
strongly recommended.
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Other Software Documentation

Additional installation and/or setup of additional Window Book products called out in the table above is
required for using many of the wbSCAN functions associated with Multi-Carrier Trailer Manifesting.
Links to the product document for each are provided below.

e The “Multi-Carrier Trailer Manifesting Setup & User Guide”; specifically, the “Getting Started”
section (REQUIRED).

e The “AWAM Setup Guide” (necessary for using Scan2Pay with automation).

e The “AWAM User Guide” (helpful for information on how AWAM works).

e The “PostalWeb Connector Installation & User Guide” (necessary for use with Scan2Pay if
submitting Mail.dat files to PostalOne! for total automation).

e The “DAT-MAIL MSSQL Installation & Update Guide”; specifically, the “Getting Started in DAT-
MAIL” and “Enabling the Automatic Upload Of Files To PostalOne! In DAT-MAIL” sections
(necessary for use with Scan2Pay if submitting Mail.dat files to PostalOne! for total automation).

o Additional information pertaining to the installation of other software components and
setup/configuration information is provided under OTHER COMPONENT INSTALLATION and
ADDITIONAL SETUP, respectively.
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INSTALLATION

= Make sure to read and fulfill the requirements for installing/using wbSCAN before beginning the
installation process. Refer to REQUIREMENTS in this Guide for more information.

o wbSCAN runs as an “unsecure” application by default. To run it as a “secure” application, contact
Window Book.

o This document assumes that DAT-MAIL has already been installed and configured for use.

INSTALL & CONFIGURE THE WBSCAN SERVICE

The installation and configuration of the wbSCAN service is the same no matter how wbSCAN is
intended to be used — either for quality assurance/verification purposes or as part of Multi-Carrier
Trailer Manifesting.

To install the wbSCAN service, perform the following:

1. Check to make sure some other service is not already listening on the port intended for
wbSCAN (e.g. port 80). For example, if there is already another webserver installed (e.g. 11S),
this may already be happening. If so, the port that wbSCAN listens to might require
changing.

A. Using Windows® Explorer, navigate to the ‘..\WB\MDV\’ folder on the DAT-MAIL server.
Locate the “DMScanSvc” application file. Right-click on the file and select ‘Run as
Administrator’;

[E=5EeR 5
@ k:_/" . v Computer » Local Disk {C:) b WE » MDY » - | +5 | [ Segreh MOV = [
Organize [=) Open Mew folder =~ O @&
T Narne Date modified Sige
B Computer dimchimnledendelbll il
E, Local Disk (C3) {7 DiScanSve T/18/2018 5:55 P 232100
PerfLogs 1/18/2018 555 PM Ooen
Pragram Files %] domnatesibTog.di 7/18/2018 5:35 PM fl | e R
Program Files 635) (| domstabernentrabes 70741l T/18/2018 5:55 PM ! TROTIDTE T I Lo ooy
T %) DECRTA0.0LL 10/18/2016 2:10 B stion & ‘ Seanwith Microsoft Securiby Essentials...
tmip & ! ‘
Users %) DSFLETOT.dll T/LE/2018 5:35 PR Pin to Taskbar
W (%] DILUPTOT.AN TR 2018 5:35 P Pin o Sart Menu

@l ArramTAT All TARSNA B85 Phd Annliratinn wmd Restrire nrewinigs wersinms
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B. When running the application for the first time, a Windows Security Alert may display. If
not already checked, enable (i.e. check) the option to allow DMScanSvc to communicate
on Private Networks and Public Networks. Click the Allow Access button to continue;

& Windows Security Alert X

@ Windows Defender Firewall has blocked some features of this

app

Windows Defender Firewall has blocked some features of DMScanSvc on all public and private
networks.

Name: DMScanSve
E Publisher: WindowBook, Inc
Path: C:\wbyndv\dmscansve.exe

Allow DMScanSve to communicate on these networks:
Private networks, such as my home or work network

[MPblic networks, such as those in airports and coffee shops {not recommended
because these networks often have ittie or no security) H

\What are the risks of afowing an app through a firewall?

Oglowam Cancel

C. The DAT-MAIL Scan web server [ | Insecure Port=NN will display (e.g. port 80). If no
errors are reported, click the Close button and proceed to Step 2 below.

25, Dat-Mail Scan web server || Insecure Port=00 @
Loo  |performance |
1P Acldress Socket Thread Date Time Descnption
EQ Q ] TiEayalLs 163817 Listening On IP Part: 80
Log:
)Mo @ Screen ) Screen & Disk | Clear || Ban
To see this web server in your browser enter in your browser: http:/f127.0.0.1
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This screen should not contain any errors; particularly, ‘Error 10048’. Example:

Log Performance

IP Address Socket Thread Date Time Description )
(80 0 0 6/15/2018 9:50:26 ERROR: 10048 Unable to Listen on TCP Port 80

| 80 0 0 6/15/2018 9:50:26  Listening On IP Port: 80

(8 0 0 6/15/2018 9:50:21 ERROR: 10048 Unable to Listen on TCP Port 80

80 0 0 6/15/2018 9:50:21  Listening On IP Port: 80

80 0 0 6/15/2018 8:50:16 ERROR: 10048 Unable to Listen on TCP Port 80

80 0 0 6/15/2018 9:50:16  Listening On IP Port: 80 v

The most common source for this error (if it does display), is that ‘DMScanSvc’ is already
installed as a service and is running. Navigating to ‘Services’ via the Control Panel >
Administrative Tools, and stop the service, the errors will stop.

o If a problem is being reported and it is not the problem noted above, contact Window Book.

2. Install the DMScanSvc, service.

A. As an administrator, go to a command prompt on the server where DAT-MAIL’s product
files are installed (not the data server);

B. Typein, “cd \wb\mdv” (no quotation marks and a single, blank space between “d” and
“\”) on the drive DAT-MAIL is installed on; and

o In the screen image below, DAT-MAIL is installed on the “C” drive. This can vary by Client.

C. Then type, “DMScanSvc /iss” (no quotation marks and a single, blank space between “c”
and “/”) and press ENTER on the keyboard. No confirmation will display on the screen
when the service is installed.

BN Administrator; Command Prompt - O H
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% If the log on credentials used on the server do not have administrator rights, the following error
will display. Click the OK button to resolve the dialog and log on to the server using administrator
credentials. Repeat Step 2 in it’s entirety.

I"ﬁlindnwllnnk Drat-Pelail Scan web server Sendice pxcd

Service could not be started, a3 it failed to Install.
Dt ScanSve Service failed ba install,
N Can't create service entry. Mo Service Control Manager available,

f ; Error = fAccess is denied, (5)
Check your security access rights,
Mame = [[MScanse]

DisplayMame = [Window Book Dat-hail Scan web server]
Ezecutable = ["CAHOWENMDWADM Scan 3w exe”]

3. Change the DMScanSvc login.
A. Onthe server, launch ‘Services’ from the Control Panel;

B. Locate the “Window Book wbSCAN service” in the list. Right-click on the service and
select ‘Properties’;

2 Sapdices e[ - ]

File Action  View Help
e |EETc=Hm »auw

o Zervices (Local) ! Services (Local)

Window Book whSCAN service Marne Description Status Start, *
o Wilware Tools Provdidles su,.,  Started Autol
L she sevice o Walurne Shadowe Copy fanzges an... Flan
L e bClient Enables Win... [ETT
Description: L4 Windew Baok Dat-Mail Database Processes hi.. Started Autor
Web server forwhLAN application 7% yiindow Book DM Import Dacmon Service Pdan

IailDrop E..

S Windos Budio Sop arted Autor
L Windons Audio Endpoint Builder Pause arted Autor
L Windowss Backup (raree Fdar
L4 Windows Biometne Service Pty Pdarie
L Windonws CardSpace btan.
L Windons Color Spstern All Tasks k tlant
L Windovs Connect Now - Config Reg [GET
L5 Windenws Defender R Pdar
L Windows Driver Foundation - User-m E Mant{i
o Windons Ervor Reporting Service [ETT
L4 Windows Event Collector Help [ ETT
S Weindews Event Lag This tervice ... Started Autor
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C. Select the ‘Log On’ tab and then the option ‘This account’. Enter the login and password
the Client will be using for the “Window Book Dat-Mail Scan web server”, service;

Win -Wlail Sean web server Properties fLocal Computer)

Geredd | Log On | D:-'.'eu.ll Dapmdancia-sl
Liog on asx

O Lol System account
Aoy sarvice o inkaract with d*.‘.h':il

@ Thiz account: VITIEAT Browse .
Passwond: ITTIITT]

Conlim pazswand.  #essssss

Hala me carfiurs user sccourd lag on oolions

Windew Book Dat-Mail Scanweb server Broperties (Local Computer)

| Generd | Logfn| Recaven |Dimd&mi&s|

Select e computer's resporse f this service fale, Help me e up racovany

D. Select the ‘Recovery’ tab and set the actios,
three failure actions to “Restart the First Felures: Freshard (he Service =
Service”. Second faitne Resian lhe Service -
In addition, make sure the “Restart S e Elsaieilon Saien =
services after” option is set to 0 fecet fal count after. 2 days
minutes. Rezlal zenvice aler 0 MiLREs

[ Enable actians Far staps wilh enoes Bimzsan Computer Dptions..
When finished, click the Apply
button;

Fun pragram

Appand Fail count 1o end of command lne [fail=%1%)

ok [ Concel [§[  &es |

E. AServices dialog will display. Click the OK button to resolve the dialog;

Sepices [=E3s]

Thie roewa logion e well ot bake affect unbd wow 9op and restart the
i e
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F. Select the ‘General’ tab. Click the Stop button to stop the service. Once the service is
stopped, click the Start button and make sure there are no errors returned. Click the OK

button when finished.

Dist-hail Scan web server Properties (Local Cormputer)

Geretd | fog On | Recaven | Dependancias|
Service name;  [EIEETETENR
Diizplay name: “window Book Datbal Scan web e

Description: Talel setvet foi Dalbal Sean

Path by evacutable:
"CONWENMOVAD MG canSwcane”

Startup bype: Lutomalic

Halo e confiqus service slaiug aplions

Service dabus:  Staited

Chait [ Shop Paus=

Froen hee:

ok | [ Cancs

B esume

You can speciip the stat parametess that appk wien you shant the zervice

Spply

Window Book Dat-hail Scan web server Properties (Local Computer)

Geretd | Log On | Recoven | Dependancies |

Service name DM EcanGve
Diisplay nams: “window Book Datbdal Scan web senven

Description: Twleh gesve far Dalbal Sean a

Pati b enacutable:
"CONWEAMDVAD M S canS e ane”

Startup bpe: Lutomaic: i

Helo e confiquis sevvice slalug oplions

You can specify the shart parametess that apolky when you stait the zervice
Froem here

Slarl perameters

| [e]8 Cancel Appip

4. Test wbSCAN.

A. Open a web browser (use Chrome if it is available);

B. Enter “127.0.0.1” (no quotation marks) as the web address;

C. The wbSCAN user interface (Ul) will display. Click the Login button;

¥R WhSCAN x  +
&« C @ 127.0.0.1/IndexPage
||||||||l||||S CA N
Login

whbSCAN web application

whbScan user logins and passwords are managed in DAT-MAIL Security - see your IT administrators for new logins.
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% If the following message displays after attempting to login to wbSCAN, the key DAT-MAIL is
registered with does not include rights to wbSCAN. Contact Window Book Client Services to

obtain an appropriate registration key.

R whSCAN x4+
r

« C @ 127.00.1/AndexPage

|||||u|n||S C A N
whSCAN web application
Your current DAT-MAIL registration is not authorized to access wbscan, @

D. Enter the login credentials as dictated by the Security function in DAT-MAIL, i.e. Login =
ADMIN, password = ADMIN. Click the Login button.

= Login

Login: [
Passyviord:

ot I_;||;|i|1

o Clients can control who gains access to their wbSCAN application through the ‘Security’ function
in DAT-MAIL. This also includes changing the default “ADMIN” login credentials. Refer to the

DAT-MAIL Security User Guide for more information.

wbSCAN’s main or home screen will display.

wh whSCAN x4
w

= C @ 127.0.0.1/IndexPage

WoSCAN

Scan @ Browse © Logaut
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5. Determine the private IP address of the server.
A. Onthe server, launch a command prompt;
B. Type IPCONFIG and press ENTER on the keyboard; and

C. Write down the IPv4 IP address.

[54.) Cisvindoerssyaten 3 Bemd exe — | [=} I

ation. ALl rvights »

Default e, TR

wnnel adapter
Hedia State . . . . . . .

Cm

Conleers UHlzer WTHDOWEOOK > _

6. Access WbSCAN from a network device.

wWbSCAN™
Installation Guide

A. On a network device, open a web browser (Window Book recommends using Chrome if

it is available);
B. Enter the IPv4 IP address from Step 5 above as the web address; and

C. Bookmark this in the browser as “wbSCAN”.

For mailers using wbSCAN for quality assurance/verification purposes only, the installation and
setup of wbSCAN is complete. For user instructions, refer to the “wbSCAN User Guide”.

OTHER COMPONENT INSTALLATION

wbSCAN relies on other Window Book software components to have access to certain data and be able
to perform certain tasks when using it in conjunction with Multi-Carrier Trailer Manifesting. Information
pertaining to the installation of these software components is documented in this section. Setup and/or

configuration information is provided under ADDITIONAL SETUP.
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Automation Scheduler

The Automation Scheduler with the Auto Postal Updates plug-in is required for downloading and
updating Facility data. This data is necessary to be able to display/select Entry Points when creating and
defining manifests for Direct Trailers.

Refer to the “Automation Scheduler System Guide” for installation instructions. Information for
configuring the Auto Postal Updates Plug-in is provided under AUTOMATION SCHEDULER in the
ADDITIONAL SETUP section in this Guide.

o Installation should occur on the same machine that the wbSCAN service is installed on.

o For many DAT-MAIL Clients, the Automation Scheduler and the Auto Postal Update plug-in is
already installed/configured. If this is the case, wbSCAN Clients can skip this step of the wbSCAN
installation process.

I i chr Beo ok vk vk on Schie chaber

]
i
H

B
:
£
3
:
:
®
!

5
Auto Postal Data Updates B
=

m

Select Configuration o

®

Abaut Auto Postal Data Updates :

|

i

Varon: E2052

=
Ly

Cwacriptins: Thin plug-in i ured 12 desmiced postal fsclity droz thip data drom the Winciow Bock web ke

Schaduda Bacommandaticn Thin phig-in thowtd ba configanm 8o mn orce par dey.

Cploes ,:. Help

gk Mews Coavbgrrtion =

| Epart Wimw

Bk bewekon Timm:  Marvae
Tha Auba Postal Data Updates i a Zene Configuration Componant.
Tha configuration should anky b modifad in Expen View at the
direction of a Window Book Support Reprezentatree, To add this
camponent to the Schedube, thick the Save bution below if vaiable,

A
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AWAM

AWAM is necessary for mailers who intend to use wbSCAN'’s ‘Scan2Pay’ function and intend to either
partially or fully automate the process. To be able to use AWAM, it must be registered and activated in
DAT-MAIL on the server where DAT-MAIL and wbSCAN are installed. For instructions on how to register
and activate AWAM refer to the “AWAM Setup Guide”.

% Refer to Scan2Pay & Paying Postage for information pertaining to any necessary setup in AWAM
for Scan2Pay.

PostalWeb Connector

PostalWeb Connector is necessary for mailers who intend to use wbSCAN’s ‘Scan2Pay’ function and
intend on fully automating the process by using the software to automatically upload Mail.dat files to
PostalOne!.

To be able to do this, PostalWeb Connector must be installed and registered on the same server where
DAT-MAIL and wbSCAN are installed. For instructions on how to install and register PostalWeb
Connector, refer to the “PostalWeb Connector Installation & User Guide”.

% Refer to POSTALWEB CONNECTOR under ADDITIONAL SETUP in this Guide for information
pertaining to any necessary setup of the PostalWeb Connector software.
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ADDITIONAL SETUP

This section documents how to increase the amount of time before a session of wbSCAN time’s out,
requiring the user to log back in again. In addition, information pertaining to the additional setup of the
other software components that are necessary for having access to certain data and being able to
perform certain tasks in wbSCAN when using it in conjunction with DAT-MAIL’s Multi-Carrier Trailer
Manifesting.

o Information pertaining to the installation of these components is provided under OTHER
COMPONENT INSTALLATION in this Guide.

SESSION TIME OUT

The default session timeout for wbSCAN is 15 minutes. If a login is idle for 15 minutes, wbSCAN will
require the user to login again to be able to continue to use the application. The Client can adjust the
default timeout of 15 minutes if they wish. To change the default session timeout...

1. Stop the ‘Window Book wbSCAN service’ from within Control Panel > Administrative Tools >
Services;

L0 Services - o x
File Action View Help
| @Dz Heml »onn

© Services (Local) . Services (Local)

-

‘Window Book wbh5CAN service Mame Description Status Startup Type Log On As e
\"'15; Window Baok Dat-Mail Database Pracesses hi.. Rumning  Automatic Jwmuser

Stop the FErIce £ Window Book DM Import Daemon Semvice Manual Nwmnuser

Bestart the service . " i i i
Eh Windew Baok PostalWeb Connector Window Be..  Running  Autematic WINDOWE...

Task schedu..  Running  Automatic WINDOWE...
Running  Automatic Local Syste...

Descnption:
Web server for wbSCAN application

indow Baok whSCAN service

SR sories e bR 1 Alightweig.. Running  Automatic Local Syste..
T Windews Audie m Manages au.. Running  Autematic Local Service
oy Windows Audio Endpaint Builder e Manages au... Running  Automatic Local Syste...
L4 Windows Backup R Provides Wi.. FRumning  Manual Local Syste..
Sk Windows Biometric Service The Winde... Manual (Tria... Local Svste..

2. Right-click on the “DMScanSvc.exe” file on the DAT-MAIL server and select ‘Run as
administrator’. The executable file is located in the ‘...\WB\MDV’ folder;

(e v Manage WDV - [m] >
“ Hame Share Wiew Applicatipg Iool v 9
- - 4 » This PC » Local Disk (C:) f WEB » MDY v U 2
22 Local Disk () Name - Date modified ype Size A
5] LAIE fd g 1B OF 1l ST i AP LT ERET S 1,870 B
inetpub I = gl 214720 Application exdtens,
Perflogs I E) DMScansve I Application
Prngrcrn F||€5 =] CANWVC. ]| ﬂ ML L ument
Program Files [x36) E) DMTRS2MSS| %' Run a: admiistrator o atien
Temp [7] domrateslib? s Application exdens,
Users |_] domstatemed Pin to Start atign extens,,

| DSCRTA0.DLY E Scan with Windows Defender...
| 1|

WE

sl oo £TRT A 2 Share
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3. The wbSCAN web server screen will display. Select the ‘Settings’ tab, and then the ‘Site’ tab
that’s within the ‘Settings’ tab. Make the desired adjustment to the ‘Session Timeout’
(default is 15 minutes). Click the Close button to save the changes; and

A whSCAM web server || Insecure Port=80

web folder: [cawsmoviweb

=

Server Headers

session Timeout: 00415 @

4. Make sure to start the ‘Window Book wbSCAN service’.

AUTOMATION SCHEDULER

The Automation Scheduler with the Auto Postal Updates plug-in is required for downloading and
updating Facility data. This data is necessary to be able to display/select Entry Points when creating and
defining manifests for Direct Trailers.

No end-user configuration
of the Auto Postal Updates
plug-in is necessary except
to click the Save button on
the plug-in’s main screen
after the installation and
registration of the
Automation Scheduler is
complete.

Refer to the “Automation
Scheduler System Guide”
for instructions;
specifically, the section
titled “Auto Postal Updates
Plug-in”.

T ek B ke ot et Scheddber

Cammently Schedubed Flug-ins ()

Auto Postal Data Updates

Select Configuration

Sedect Cosliguration i

About Auto Postal Data Updates

b=

Vamion: E2030

=
)

uszspine: This plugein it usedis dowmiesd petsl fss ity droz thip dats o the Windmw Back web tka

o | Hep L

Schaduls facammandaticn: Thin phig-in sheuld ba configared % ron oree par day.

Cplons

g M ew Conbiguriion
| Expart iew

bt brwsbon Tirvm:  larvar

Tha Auts Pestal Data Updatas i 3 Zans Configuration Campanant.
Tha configuration should anky be ereodifad in Exgart View at the
directian af & Window Book Support Aeprezantative, To sdd this
camponent to the Schadule, chick tha Zave bution below i avaiabls,

o For many DAT-MAIL Clients, the Automation Scheduler and the Auto Postal Update plug-in is
already installed/configured. If this is the case, wbSCAN Clients can skip this step of the wbSCAN

configuration process.
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DAT-MAIL SETUP REQUIREMENTS

There are setup procedures in DAT-MAIL that are required for all users before using wbSCAN in
conjunction with Multi-Carrier Trailer Manifesting including, but not limited to, adding carrier
information and distribution center(s). There are additional setup requirements that differ for generic
users (i.e. non-LSC users) and LSC users. All setup information is provided in the “Multi-Carrier Trailer
Manifesting Setup & User Guide”; specifically, the “Getting Started” section.

=2

1 l b

| |
.

L Y

"’ Make sure to read, understand, and implement the applicable instructions found in the “Getting
Started” section of the “Multi-Carrier Trailer Manifesting Setup & User Guide” before attempting
to use wbSCAN!

Other wbSCAN functions requiring setup in DAT-MAIL are documented below.

Scan2Pay & Paying Postage

To use the Scan2Pay function and to pay postage via AWAM, the functions must be enabled in DAT-
MAIL.

If Scan2Pay is not enabled in DAT-MAIL, the ‘Scan2Pay’ tab will not display in wbSCAN’s Activate Pallets
screen.

Activate Pallets

Scan Scan Log

Location: | -

Scan Value: |

+ Sawve @ Cancel

To enable these functions, from DAT-MAIL’S main screen, select the ‘Other Programs’ > ‘IM Scanning’ >
‘Tagger Interface Setup’ menu options.

B DAT-MAIL Editor with Toolbox =1 FoR 5|
File Reports PostalOne! Utilties ToolBox 'Other Plogmml Logistics  Security  Help
b~ o Other Programs Set 3 o
= & . X (I er Programs Satup @u' @ [ ‘
Palletization

Spoilage Tracking Utility
IM Scanning
vU! 0g Setup View Scan Manager Reguests Log
Manage PMOD Shipments I Tagger Interface Setup I

WHSCAN Setup

Export to Tagger
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E) Tagger Settings

The Tagger Settings screen will display. {UuHSunHmmv@

Enable (i.e. check) the ‘Use IM Scan

Wihitiar Sehup

Manager’ option. Click the OK button

to save the changes and close the Export Cnticnz

Dtk Tegoer export folder:
screen. —

Next, select the ‘Other Programs’ > ‘IM Scanning’ > ‘wbSCAN Setup’ menu options.

-

B) DAT-MAIL Editor with Toolbex : BN HoR =X
File  Reports PostalOnel Utilities ToolBod | Other Programs | Rogistics  Security Help
T 3 s Setu 3 - @ '
D@ X w2 P é.»"ul‘il
Palletzation

Spoilage Tracking Utility

IM Scanning
ST Views Scan bdanager Requests Log

Manage PMOD Shipments Taqger Interface Setup
whSCAN Sstup

Export to Tagger

The wbSCAN Setup screen will display. Enable (i.e. check) the ‘Use Scan2Pay’ option. Enabling this
option also enables the ‘Allow wbSCAN to pay postage via AWAM’ option. Select (i.e. check) the pay
postage via AWAM™ option if desired.

o This procedure assumes AWAM is already registered and activated in DAT-MAIL. Refer to AWAM
in this Guide for more information.

B wh3CAN Settings [meiie]
o U ScaniFay
| Al winSCAN b pay postage vis AWM
AAEH Prohle: []
Diafaull Location Categony Code: U
0 ] [ Cocel |

(53 whSCAN Settings =
If the option to allow wbSCAN to pay postage via
AWAM is enabled (i.e. checked), use the browse 0] Use Sican2Pay
button to select a specific AWAM post processing I R R L R L
profile to use Scan2Pay to generate statements I A L]
and export payment submissions to PostalOne!®. M LT BT s fua]
0k ] [ Cance |
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The DAT-MAIL AWAM Browse
Profiles screen will display.
Highlight an existing AWAM
Post Processing profile and
click the Select button or click
the Insert button to create a
new profile.

Refer to Creating An AWAM
Post Process Profile for
instructions on how to create
the profile.

Additional Setup

B DAT-MAAIL SN - Brcoase Profiles

Frofiie Tyas

Import Falh
Pt Pribizing

C

—r‘.—

—L’

Frafia Tyha Fidarn
Pheed Prscasce=s

Change Profia Typs

Chose

Use the browse button to create and/or select a default ‘Location Category Code’ that will be assigned
to any newly scanned location in wbSCAN. This will negate the need for a look-up of a location category
code on the wbSCAN Location Edit screen (unless it needs to be changed).

(B0 whSCAN Settings

o Uz ScaniPay
1 Ao whSCAH b pay postage vis AWAK
Aadakd Frofile: whSCAN Scan?Pay

==

Dafaudt Location Categany Code:

The Manage DIMELocCategory screen will display.
Highlight an existing Location Category and click the

Cad
Select button or click the Insert button to create a new -
category.

Refer to Creating A Default Location Category for -

instructions on how to create and select a default

location category.

[ et

B Ianage DIMELocCategory

Descoption

==

Function Code: |

ﬂ.ﬂ"aﬂgﬂ |[ Delete I Select ]I' Clese
~

% IMPORTANT: If changes are made to the wbSCAN settings, the “Window Book DAT-MAIL Scan
Service” (i.e. Windows Services) must be stopped and then restarted before the changes will take

effect.
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CREATING AN AWAM POST PROCESS PROFILE

If a mailer chooses to have wbSCAN pay their postage using AWAM, they will need to create a post
process profile. They should click the browse button in the wbSCAN Settings screen to create the
profile.

) whICAN Settings ==
< Usza ScanPay
| Allows whSCAN to pay pastoge wia Ais
A Prokile: L]
Diafault Location Cabagony Code: |_|
ok 1 [ comn |

o The profile can also be created through AWAM directly (within AWAM, click the EDIT PROFILES
button, then click the INSERT button and select ‘New Post Process Profile’); however, for the
purpose of this document, the profile is being created via the ‘wbSCAN Settings’ screen.

) CT-3A01L SWAM - Berwse Profiles ==

Frolie Mers Mol [y el Falh

The DAT-MAIL AWAM — Browse
Profiles screen will display.
Click the Insert button (the

oo Tepes Pl
profile type of ‘post process’ is ¢
selected automatically).

]

Crse

Once a new profile screen is launched, enter a Profile Name. Enter a name that is easily identifies the
profile’s purpose (e.g. “wbSCAN Scan2Pay”).

‘General Settings’ tab:

e Determine whether statements should be generated (i.e. select the ‘Generate Statements’
option) or if the system should only create release files (i.e. select the ‘Only Create Release Files’
option);
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e Select (check) the option ‘Generate Statements Automatically’;

o Perform the Statement Setup or Release Mail Setup (depending on which option was enabled
(first bulleted item in this list) by clicking the appropriate, corresponding button (you can print

statements or quick statements) automatically)); and
e Select (check) the option ‘Generate Statements only for that contains already marked ready to

pay'.

EJ DAT-1AAIL AWAM - Profile Wil Be Added
Frofile Name: whSCAN Scan2Pay @
Pogt Processing

General Settings | Auke Expers | o | Aleliong || Dabes | Inteligent sl Bacode

[ Gersiate Slatemerts Only Create Releaze Fles

W Genesabe Stabements Automatically

Stalement Selup Statemerl Selup Complaled

o Genesabe Siatements ordy for the conkainess alveady marked ready to pay

e T T

Batch Reporis Setup

‘Auto Exports’ tab:

e Select (check) the option ‘Export PO! Update Release File Automatically’.

B DAT-BAMIL AWAM - Profile Will Be Added [ =]

="

Frofile Hame: whSCAN Scan?Pay
Prst Processing
Gereral Settingl| Auto Experls ez | lianc || Dates | Inteligent Mal Bacods

Job and =ML Exportz | CSW Expaits

Ao Exvpont
| Auto Expart after Impart Expont Satfing:
Export Roat Foldar Mame:
Export Fokder Tennplzbea:
Expait File Name Templale  [JOEID]

ML Prstags Export
7] Enshle *ML Postage Expent Exponl Seltings
Eupart Falder Hame:

Expait File Mame Template

L1 twitn Fenogl P11 Oernsl Fils [¥] Expail usng Hisleeizal JeblD
(] {Expat
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‘Dates’ tab:

e Use the options in the ‘Dates’ tab to update the dates in the Mail.dat file to reflect the scan date
as the ship date or payment date. The ‘Scheduled Ship Date’, Actual Container Date’, and
‘Postage Statement Mailing Date’ should be set to “Today”. If the intent is processing to ship
tomorrow, add 1 day to each setting (i.e. “Today” + “1” day).

) DAT-RAAIL AN - Profile Will Be Added ==
Profile Hame: whSCAM ScanZ?Pap
Poat Procesing
Gerersl Sating: || Aute Expeats | [Faleiizfl] Dates |I|Ie\lgenl Ml Ecade
USPS Pickup
@ Euishng ) Blark i) He O Yes
Scheduled Ship Date (CSM-1172) Todw  [w] Pl [0 3 Daps <:
Schedulad Induction Stam Dae [CEM-1117) Exizting E Pluz |0 & Daps
Scheduled Induchon End Dabe [C5M-2001) Exstng E Flez |0 = Daps
Schaduled FickUp Date [CSMA177); Esistng [=] Plus [0 % Daps
etz Corbzines Ship Date [CSM-1113), Today [=] Pz [0 % Do <:
IrvHorme Date [CEM-1115¢ Exiging  |=| Pl [0 2 Daps
Paslage Stalemert Malrg Date [C58-1184) Today E Pl |0 2 D @

When finished, click the OK button to save and close the new AWAM post process profile. The DAT-
MAIL AWAM — Browse Profiles screen will display. Select (highlight) the newly created post process
profile and click the Active & Select button.

B DAT-MAIL AWAM - Browse Profiles

Profile Mome Profils Type Impott Path | nctvals & Selecl ]
PostProcessing -

) whSCAM Settings bt
The DAT-MAIL AWAM — Browse Profiles screen will
close and the wbSCAN Settings screen will display.
The name of the newly created/selected ‘AWAM

Use ScanZPay
[ Allaw whSCAN 1o pay pastage via AWAM

Profile’ will show on the screen (e.g. “WbSCAN AWNAM Proffe: SeandPay B
Scan2Pay”). Click the OK button to close the S
screen. oK Caneel

% IMPORTANT: If changes are made to the wbSCAN settings, the “Window Book DAT-MAIL Scan
Service” (i.e. Windows Services) must be stopped and then restarted before the changes will take
effect.

o Fully automating the Scan2Pay process requires the automatic upload of Mail.dat files to
PostalOne! Refer to POSTALWEB CONNECTOR in this Guide for more information.
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CREATING A DEFAULT LOCATION CATEGORY

Specifying a default location category code in DAT-MAIL will negate the need for a look-up of a location
category code in the wbSCAN Update Location screen (unless it needs to be changed).

Update Location ®

General

Location: || |
Cateqory: |wyse » ‘warehouse Caregoru<:|

« Save @ Cancel

To create and select a default location category in DAT-MAIL, select the ‘Other Programs’ > ‘IM
Scanning’ > ‘WbSCAN Setup’ menu options.

.-

B) DAT-MAIL Editor with Toolbox
File Reports PostalOnel Utilites ToolBo

O @ X [

=N EOR =X

ogistics  Security Help

s Setup g&& [‘il

Spoilage Tracking Utility

IM Scanning Export to Tagger
g Views Scan Manager Requests Log

Other Programs

Uther ¥rogra

Palletzation

Manage PMOD Shipments Tagger Interface Setup
whSCAN Sstup
B) whSCAN Settings [l

The wbSCAN Settings screen will display. Use the

browse button to create and/or select a default (] Hea ScanzPay
. . . o H 1
‘Location Category Code’ that will be assigned to 2T DTG R A 03
any newly scanned location in wbSCAN. ALl LSRRI
Diafault Location Categary Code: U
Lok | [ Concol |
B Manage DIMELocCategory 1

The Manage DIMELocCategory screen will display. Click
the Insert button.

o If the desired Location Category already exists,
highlight it and click the SELECT button.

| Delete || Select || Closs
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The Form DIMELocCategory screen will display. Enter the following:

e ‘Category Code’: A brief description or abbreviation that will be used to identify the category
and can be used as a column header on a report (e.g. “WHSE”);

e ‘Description’: Describe the Category (e.g. “Warehouse Category”; and

e ‘Function Code’ (e.g. “1”): A numeric value that stands for a specific production function that
could be tied to multiple category codes.

B} Form DIMELacCategary
Categone Codst  WHSE Click the OK button when finished.
Desenpliar: Warghouse Catagary
Function Code: 1
E k. i Cancal ] k) banage DIMELocCategory
Code Descoption Function Code:

Mo Location Catego [1]

With the newly added Category Location highlighted,
click the Select button.

[ nsest || Change || Delete I Select | | Ciose

B‘ whiCAN Settings 1
The code specified for the selected Location
(&) Usa ScanPay Category will display in the ‘Default Location
=l T R LS et Category Code’ field in the wbSCAN Settings
AEM Frofle: whSCAN Scan2Pay [ screen.
Diafault Lecation Catagoy Code:  WHSE E’_‘J
| oe || Caea | | Click the OK button to close the screen.

% IMPORTANT: If changes are made to the wbSCAN settings, the “Window Book DAT-MAIL Scan

Service” (i.e. Windows Services) must be stopped and then restarted before the changes will take
effect.

The Default Location Category Code specified in DAT-MAIL will auto-populate in wbSCAN’s Update
Location screen for the user when a new location is scanned. The default code assigned to the location

in wbSCAN can be changed if necessary, using the look-up function (i.e. * ). Changing the code in
wbSCAN does not change the code specified as the default in DAT-MAIL.

Update Location

Gensral

Location: || |

Category: ynse | , Wtarehouse categnru<:

« Save @ Cancel
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DIME Users

o The information provided in this section assumes DIME has already been setup/enabled in DAT-
MAIL. Instructions for enabling DIME in DAT-MAIL are provided in the “Multi-Carrier Trailer
Manifesting Setup & User Guide”; specifically, the “Getting Started” section.

Y

= The ‘Allow changes to data during import’ option in DAT-MAIL’s “Setup” screen must be enabled
(i.e. checked) for DIME users. The “Setup” screen is accessible via the ‘File’ menu > ‘Program
Settings’ > ‘Program Setup’.

E) Setup *

Confainer Tare Weights Expon Archive Advanced Saltings Palie? Trackingintzligenl Mai

Jatenanco Labeling List Validaton Logistics PMOD
impart efauls  Wuader mesrmation  Planalyzer  PostalOne!  Stabement Generation  Start Up Opbions

SingleFie  Daemon  Daemon Auto ... EI Eyne Ssitings | Use AWAM
Default Zngle Fie Path CAWB rmiail clat
Defauk Processed Path Palh has been nol specified, fies wil net be maved
ol Conformance Testing

() e Auto Validabicn () Confosmance Calegory:

[ alow ehanges to data during impart
- Vgl e

- B = L IDE&ANBance Conformancs _IE$1|!'II} il
[ set Ship Date To Zero Wark Container Status
[ oelete iMother Fatets {® Mo Change () Preliminary () Blank
A NDC UxNDC SCF
[ Recak: Container Weights Afer import ] oo mot h:uurt%‘iece IEIEt,aiIFiE
[ Run Freight Takle & fler bnpoet ek ess Letan e

] Run PMOD Export

Asda Eunset O Moisinl Eie & S bt

AUTO-CREATE ORDERS

To enable the function that automatically creates orders when pallets are activated in wbSCAN, from
DAT-MAIL’s main menu, select ‘Logistics’ > ‘Maintenance’ > ‘Settings’.

B DAT-MAIL Editorwith Toolbos . (== o )
File Reports  PostalOne!  Ltilities  ToolBox  Other Pr\qgram_:urdy Help
b # - }{ h j; PGPS;EQE' % blulb-Carn rTrl|:rManiF:shng :m
< [
File Maintenance Ly
TOM Pooled Quotes M TR T — k
. Settings
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The DIME Setup screen will display. Select (i.e. check) the ‘wbSCAN will Auto-create orders when
activating pallets’ option. Click the OK button to close the screen and save the new setting(s).

DIME setup

Transportation System Access

+ Tegt Only. Do not production datab

User ID: AcmeDemao

Site 10: 12407

Password: T

URL for Test Site: http:jidynamail.Isccom.comfdimef2.2. 4fcenification/dime. svoibasicText

URL for Production Site:  http:}fdynamail.lsccom.comfdimef2241 dime.swe/basicText

Default Carrier: LSC + LSC for Dropship/Copal
Default Consolidation Facility: 11141 + Bolingbrook

¥ whSCAM will Awto-create orders when activating pallets

whiSCAN “Add pallets to Manifest” scan will update eB0OL automatically

AUTOMATICALLY UPDATE EBOL

o The information provided in this section assumes DIME has already been setup/enabled in DAT-
MAIL. Instructions for enabling DIME in DAT-MAIL are provided in the “Multi-Carrier Trailer
Manifesting Setup & User Guide”; specifically, the “Getting Started” section.

To enable the function that automatically updates the eBOL as pallets are scanned/added to a manifest
in wbSCAN, from DAT-MAIL’s main menu, select ‘Logistics’ > ‘Maintenance’ > ‘Settings’.

E) DAT-MAL Editor with Toolbox . (== ER =)
File PReports  PostalOnel  Utilities  ToolBox  Other Program] Fcounty Help

1; 5j  Postage  TAGS hlulti-Carrier Trailer Manife st
5 | g - 4 (9 ﬁ s Iﬁ arrier Trailer Manifesting :m
File Bdaintenance LA

TOM Pooled Quotes B IR S k
Sl!t‘l:ings
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The DIME Setup screen will display. Select (i.e. check) the ‘wbSCAN “Add pallets to Manifest” scan will
updated eBOL automatically’ option. Click the OK button to close the screen and save the new
setting(s).

% The ‘wbSCAN “Add pallets to Manifest” scan will updated eBOL automatically’ option can only be
enabled (i.e. checked) if the DIME production database is being used. If the ‘Test Only’ option is
selected, the ‘wbSCAN “Add pallets to Manifest” scan will updated eBOL automatically’ option
will be grayed out.

. DIME setiep

I[ﬂﬂﬁﬂ!dﬂ!iﬂﬂ System Access

7| Test Onky. Do not aceess production database,

User 1Dz AcmeDemo

Site 1D 12407

Password: T

URL tor Test Site: httpz/dynamail.lscecom.comfdime}2 2. dfcertificationfdime. swofbasicTesxt

URAL far Production Site:  witpofidynamaillscoom, comfdime! 2247 fdime. svelbasicTexd
Defaull Carrier: LSC # LSC for Dropship/Copal
Default Consolidation Facillty: 11141 4+ Baolingbrook

| whBSCAMN will Auto-create orders when activating pallets

¥ whSCAN “Add pallets to Manifest” scan will update eBOL automatically

E 0K ; Cancel

POSTALWEB CONNECTOR

PostalWeb Connector is necessary for mailers who intend to use wbSCAN’s ‘Scan2Pay’ function and
intend on fully automating the process by using the software to automatically upload Mail.dat files to
PostalOne!.

To be able to do this, the PostalWeb Connector software must be configured to use DAT-MAIL, and the
USPS PROD MDR Client must be created/configured. Refer to the “PostalWeb Connector Installation &
User Guide” for instructions; specifically, the “DAT-MAIL Settings” and “MDR Client Configurations”
sections.
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TROUBLESHOOTING

LOGS

wbSCAN is in active development and is logging almost every exception. The log file name is as follows:
WB\MDV\Data\DMScanSvcLogs\YYYYMMDD_DMScanSvc_log.txt where YYYYMMDD represent
current Year, Month and Day numbers. This is the first place to look for a reason of any problem
reported.

MONITORING

If a Client wants to see in real-time what wbSCAN is encountering, they should stop the DMScanSvc,
service and then launch it as a desktop application (i.e. “...\wb\mdv\DMScanSVC”). The desktop
application will display what it is doing.

DETERMINE WHAT PROCESS IS MONITORING
PORTS

If a Client detects another application listening to the selected port (e.g. port 80), they should figure out
which one it is, especially if the Client is not using another webserver like IIS. To do this, perform the
following:

1. On the server, launch a command prompt;

2. Enter “netstat -o -n -a | findstr 0.0:80” (no quotation marks — enter whatever port number is
being used — in the example here port 80 is being used) and press ENTER on the server’s
keyboard;

3. The system will return a PID number identifying a process listening on the specified port
(e.g. port 80) on the computer (in the example here, the PID number is “4”);

CAWINDOWS\system32\cmd.exe
Y
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4. Onthe server, launch the ‘Task Manager’ and select the ‘Details’ tab. Sort by PID and look
to see what process is using that PID (in the example here, PID 4 is being used by the
System, the description for which in this case is “NT Kernel & System”);

1% Task Manager - O X
File Options View

Processes Performance App history Startup User[ Details Bervices

Name PIDA Status User name CPU Memory (p... Description A
@71 System interrupts - Running SYSTEM 00 0K Deferred procedure calls...
@7 s 0 Bunping SYSTEM 99 SK D i
(] System 4 Running SYSTEM 00 ;:_ﬂw
L exe k 1 Running DW= T 00 3 Op vWindow ana...
(5] smss.exe 340 Running SYSTEM 00 0K Windows Session Mana...
%7 LogonUl.exe 360 Running SYSTEM 00 4,276 K Windows Logon User In...
® | winlogon.exe 376 Running SYSTEM 00 592K Windows Logon Applic...
[®7] SkypeHost.exe 388 Suspended ofomin 00 48K Microsoft Skype
[®] svchost.exe 448 Running NETWORK.., 00 37,880K Host Process for Windo...
[ csrss.exe 456 Running SYSTEM 00 536K Client Server Runtime Pr...

5. Although it is not evident, this particular process (i.e. “NT Kernel & System”) is running a
service called “World Wide Web Publishing”. On the server, open ‘Services’ (i.e. Control
Panel > Administrative Tools > Services). Navigate to the “World Wide Web Publishing”
service, right click on it, and select ‘Stop’;

~

World Wide Web Publishing Service Name

|' | Status Startu

) Gk Windows Update Manu
%ﬂath:::?xce &, WinHTTP Web Proxy Autc me Running Manu
Q, Wired AutoConfig . Manu

&) WLAN AutoConfig A% Fesks < Manu

g“‘f:’Pt"\”U’ : s G} WMI Performance Adapte  Refresh Manu
TOVICES Yen conaectiy &, Work Folders Properties Manu

administration through the Internet
Information Services Manager

AWorld Wide Web Publishin. Provides W., Running

it
&l Xbox Accessory Manageme... This service ... Manu
I8 Viino Ramma Aanibasine This santisa [V .
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6. Once the service is stopped, right click on it again and select ‘Properties’. In the ‘General’
tab, locate the ‘Startup type’ field and, using the drop down provided, select “Disabled”
from the list. This will disable the “World Wide Publishing Service” so that it no longer
interferes with wbSCAN on port 80.

World Wide Web Publishing Service Properties (Local Computer) X

General llogOn Recovery Dependencies

Service name: W3asveC
Display name: Wordd Wide Web Publishing Service

Description: Provides Web connectivity and admirsstration
through the Intemet Information Services Manager
Path to executable:
C:\WINDOWS\system32\svchost .exe « iissvcs
—
Startup type: Automatic | ~
Automatic (Delayed Start) )
Automatic
Disabled
Service status: v?.ai.rrl\—
Start Stop Pauss Resums
You can specify the start parameters that apply when you start the service
from here.
Start parameters: f ]

[ ] o 1

o For more information on this process, refer to: https://www.mydigitallife.net/how-to-check-and-
identify-which-application-is-listening-or-opening-port-80-and-443-on-windows/.
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USING A HANDHELD DEVICE WHILE USING A CELL
NETWORK

Clients may want to expose wbSCAN to the internet in order to use a handheld device using a cell
network. To do this, perform the following:

e Determine the public IP address of the server using https://www.whatismypublicip.com/. This
will be the IP address used to access the service, not the private IP; and

e Open up the firewall and set up rules to access. This will vary by firewall.

It i 'l
= WARNING: Opening up the firewall and setting up rules can make the Client’s network more

vulnerable to attacks. Contact Window Book’s Kenneth Copeland for assistance.
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